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“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
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The information in this document is current as of October, 2007. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not 
all products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":
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INTRODUCTION 
 

 

Readers This manual is intended for users who use 78K0R Series or 78K0 Series C Compiler 

and develop its application systems. 

 

Purpose This manual describes a tool that calculates the stack usage amount, using the 

assembly language source output by the 78K0R Series or 78K0 Series C compiler, 

and displays the analysis result in the tree format. 

 

Organization This manual consists of the following chapters: 

 

• OVERVIEW 

• INSTALLATION 

• STARTUP AND TERMINATION 

• INPUT/OUTPUT FILES 

• WINDOW REFERENCE 

• MESSAGES 

 

Related Documents The table below shows the documents (such as user’s manuals) related to this 

manual.  The related documents indicated in this publication may include preliminary 

versions.  However, preliminary versions are not marked as such. 

 

Documents related to development tools (user’s manuals) 

Document Name Document No. 

SK78K0R Ver. 3.02, SK78K0 Ver. 2.20 Stack Estimation Tool This document 

BS78K0 Ver. 1.10 Bank Support Tool U17843E 

Operation U17201E CC78K0 Ver. 3.70 C Compiler 

Language U17200E 

Operation U18549E CC78K0R Ver. 2.00 C Compiler 

Language U18548E 

Operation U17199E 

Language U17198E 

RA78K0 Ver. 3.80 Assembler Package 

Structured assembly language U17197E 

Operation U18547E RA78K0R Ver. 1.20 Assembler Package 

Language U18546E 

SM78K0 Series Ver. 2.52 System Simulator Operation U16768E 

SM+ System Simulator Operation U18010E 

ID78K0-NS Ver. 2.52 Integrated Debugger Operation U16488E 

ID78K0R-QB Ver. 3.20 Integrated Debugger Operation U17839E 

PM plus Ver. 5.20 U16934E 

PM+ Ver. 6.30 Project Manager U18416E 
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CHAPTER 1  OVERVIEW

1. 1  Functional Outline

Stack usage tracers SK78K0 or SK78K0R for the 78K0 microcontrollers or the 78K0R microcontrollers (hereafter

referred to as SK78K0/SK78K0R) is tool for calculating the amount of stack each function may consume during execu-

tion and displays the result in tree form, based on the assembly language file output by the 78K0 microcontrollers C

compiler CC78K0 or the 78K0R microcontrollers C compiler CC78K0R (hereafter referred to as "CC78K0 or

CC78K0R").

The SK78K0/SK78K0R have the following functions and features.

- It works with PM+.

- The result of calculating the stack size is displayed in GUI.

- It provides an easy user interface to specify additional stack size information. 

1. 2  Outline of Operation

The flow of the operation with the SK78K0/SK78K0R is as follows.

Figure 1-1 Estimation Flow When SK78K0/SK78K0R Is Used

.txt

.csv

.psg .txt.asm

.prj

.c

PM+

CC78K0/CC78K0R SK78K0/
SK78K0R

C source file
stk system file

Assembler source 
module file 

Project file 

Stack size specifi-
cation file

Output result file
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1. 3  Operating Environment

An environment that satisfies the following requirements is required for using the SK78K0/SK78K0R.

(1) Host machine

Compatible with the following operating systems (OS):

Windows® 2000, Windows XP Home Edition, Windows XP Professional

[Caution] It is recommended to install the latest service pack for each OS.

(2) Related development tools

- Integrated development environment Project Manager PM+ 

- 78K0 microcontrollers C compiler CC78K0 

- 78K0R microcontrollers C compiler CC78K0R

1. 4  Terminology

The terms required to understand the SK78K0/SK78K0R, operations are explained below.

- Assembler source module file (.asm)

A source file coded in the assembly language, which is output by the CC78K0/CC78K0R based on a C source 

file.  Assembler source files coded manually are not included (refer to "4. 2. 2 Assembler source module file 

(.asm)").

- Total stack size

The maximum stack size of a function that includes the stack size of its callee functions, and is calculated by the 

following formula (if the function is recursive, the value is multiplied by its recursion depth.).

Total stack size = "frame size" + "maximum stack size among those of callee functions" + "additional margin"

- Frame size

The stack size of a function itself, which does not include the stack size of callee functions.

- Additional margin

A size forcibly added to a stack size

- Recursion depth

A predicted maximum number of times that a recursive function is executed in the recursive call chain.

A recursive call is an operation that a function calls itself directly or indirectly via another function.

- Adjustment information

Additional margin and recursion depth (for recursive function)

- Size setting information 

Information (additional margin, recursion depth, and callee functions) used to adjust the values calculated as the 

stack size.
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CHAPTER 2  INSTALLATION

2. 1  Installation of SK78K0/SK78K0R

The following describes the procedure for installing the SK78K0/SK78K0R. 

(1) Start Windows.

(2) Insert the supply medium into the relevant device equipment (CD-ROM drive) of the host machine; the setup 

program will then automatically run.

If the setup program does not run automatically, start "install.exe" from the CD-ROM drive using Explorer (Win-

dows accessory).

(3) Continue installation of the SK78K0/SK78K0R, following the messages displayed thereafter.

Whether the SK78K0/SK78K0R has been installed normally can be checked with the [Tool] menu of PM+ after

installation of the SK78K0/SK78K0R is completed.

[ When installation is completed normally ]

The following two items are displayed in the [Tool] menu when a project file for the 78K0 or 78K0R microcontrollers

is opened in PM+.

 - When using SK78K0:  [Startup SK78K0]

 - When using SK78K0R:  [Startup SK78K0R]

2. 2  Folder Configuration

The folder structure configured after the SK78K0/SK78K0R installation is as follows.

Figure 2-1 Folder Configuration (When Using SK78K0)

Installation folder (default: C:\NECTools32)

bin 

hlp Help file (*.chm)

doc Document files (*.pdf/*.txt)

SK78K0 execution file sk78k0.exe 
sk78k0p.dll

dat78k0 Stack size specification files for compiler's 
library

{l0, l0f, l0sm, l0r, l0rsm}.txt

DLL file for PM+
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Figure 2-2 Folder Configuration (When Using SK78K0R)

2. 3  Uninstallation of SK78K0/SK78K0R

The following describes the procedure for uninstalling the SK78K0/SK78K0R.

(1) Start Windows.

(2) Start "Add or Remove Programs" on the Control Panel ("Add/Remove Programs" in Windows other than Win-

dowsXP).

(3) Select the items to be uninstalled.

- NEC EL SK78K0 Vx.xx or NEC EL SK78K0R Vx.xx

- NEC EL SK78K0 Vx.xx or NEC EL SK78K0R Vx.xx Documents

(4) Continue uninstallation of the SK78K0/SK78K0R, following the messages displayed thereafter.

Installation folder (default: C:\NECTools32)

bin 

hlp Help file (*.chm)

doc Document files (*.pdf/*.txt)

SK78K0R execution filesk78k0r.exe 
sk78k0rp.dll

dat78k0r Stack size specification files for compiler's 
library

{l0R, l0Rf, l0Rsm, l0Rr, l0Rrsm}.txt

DLL file for PM+
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CHAPTER 3  STARTUP AND TERMINATION 

3. 1  Starting SK78K0/SK78K0R

Before starting the SK78K0/SK78K0R, a project file created for the 78K0 or 78K0R microcontrollers must be active

in PM+.

Next, start the SK78K0/SK78K0R by performing the following operation in PM+.

- When using SK78K0: Select [Tool] menu -> [Startup SK78K0] 

- When using SK78K0R: Select [Tool] menu -> [Startup SK78K0R] 

- Click the  button registered on the toolbar

When the SK78K0/SK78K0R is started, the following Main window will open, and the amount of stack consumed by

the current project will be displayed.

Figure 3-1 Main Window (When Using SK78K0)

[Caution] If an attempt is made to start the SK78K0/SK78K0R multiple times for the same project, the SK78K0/

SK78K0R currently running will pop up.
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3. 2  Exiting SK78K0/SK78K0R

To terminate the SK78K0/SK78K0R, perform the following operation on the Main window.

- When using SK78K0: Select [File] menu -> [Exit sk78k0] 

- When using SK78K0R: Select [File] menu -> [Exit sk78k0r] 

[Caution] When terminating PM+ or when the active project of PM+ has been changed, a confirmation message will 

be displayed and then SK78K0/SK78K0R will be terminated.
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CHAPTER 4  INPUT/OUTPUT FILES 

4. 1  Types of Files Handled by SK78K0/SK78K0R

The input/output files handled by the SK78K0/SK78K0R are as follows.

[ Input files ]

- Project file (.prj)

- Assembler source module file (.asm)

- Stack size specification file (.txt)

- stk system file (.psg)

[ Output files ]

- stk system file (.psg)

- Stack size specification file (.txt)

- Output result file (.txt/.csv)

4. 2  Explanation of Files 

4. 2. 1  Project file (.prj)

A project file which is generated by PM+ contains information on source files

The SK78K0/SK78K0R reads the following information from a project file.

- Project path

- C source file

- Options (intermediate output directory/register mode/optimization option)

4. 2. 2  Assembler source module file (.asm)

A source file coded in the assembly language, which is output by the CC78K0/CC78K0R based on a C source file

registered in the Project file (.prj).

The SK78K0/SK78K0R analyzes the amount of stack consumed, based on this file.  The user cannot specify the

assembler source module file individually.

Generation of assembler source module file

(1) Select [Tool] menu -> [Compiler Options] in PM+

(2) Select [Assembler Source] on the [General] or [Output File] tab
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4. 2. 3  Stack size specification file (.txt)

A stack size specification file is a text file for collectively specifying information about stack sizes for functions (e.g.,

functions manually coded in assembly language, library functions, functions that include an indirect function call using

a function pointer, recursive functions, and functions with variable parameters) whose stack sizes cannot be obtained

accurately.

(1) Reading a stack size specification file

After a stack size specification file is read, the stack size is recalculated to reflect the information.  If some adjust-

ment information has already been specified, it is overwritten by information read from this file.

- Select [File] menu -> [Load Stack Size Specification File...]

(2) Saving a stack size specification file

The specified information and information on undetermined functions (function names) whose stack sizes are not 

determined are saved in a file.

- Select [File] menu -> [Save Stack Size Specification File...]

(3) Format

The format of a stack size specification file is composed of the function name and each of the parameter delim-

ited with a comma (,).

Spaces (one-byte spaces and tabs) are not regarded as delimiters.  Only the spaces immediately before and 

after a comma are ignored; spaces cannot be placed before and after "=".

Size adjustment information for one function can be specified on one line.  A line starting with "#" is regarded as 

a comment line, and blank lines are ignored. 

If just a function name is specified, adjustment is not applied.

- Function  [, ADD= size] [,RECTIME= time] [,CALL= func]...
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Table 4-1 Parameters of Stack Size Specification File

The following are examples of a stack size specification file and outputs before and after reading a stack size 

specification file.

Parameter Description

Function This parameter specifies the name of a function whose stack size is to be adjusted, in the 
same form as displayed by the SK78K0/SK78K0R, or in the form of a symbol name 
defined in the assembly language source.

- If a name starting with an underscore ( _ ) is described, the SK78K0/SK78K0R regards it 
as a symbol name defined in assembly language, searches for a function whose name 
matches the name from which the underscore is excluded.  If no functions hit, then the 
SK78K0/SK78K0R regards the name including the underscore as a function name and 
searches for a function whose name matches it.
For example, if a description "_func" exists and a function "func" (symbol name is 
"_func") is found in the file, the SK78K0/SK78K0R regards that "_func" as specifying the 
"func", and if not found, regards the "_func" as specifying the function "_func" (symbol 
name is "__func").

- Function names starting with a character other than an underscore are regarded as 
function names and the SK78K0/SK78K0R searches for functions whose names match 
with them.

- If a file name is not specified for a static function, the SK78K0/SK78K0R searches for a 
global function with the same name, and if no functions hit, the SK78K0/SK78K0R 
searches for a local function with the same name.
If multiple local functions hit, the local function found first is regarded as the target of 
specification.

ADD= size This parameter specifies the Additional margin (value forcibly added to the stack size).

- Specifies a decimal value or hexadecimal value that starts with "0x", from 0 to 65,535.

- This value is equivalent to the one specified in [Additional Margin] in the [ Adjust Stack 
Size ] dialog box.

RECTIME= time This parameter specifies Recursion depth (value by which the stack size is multiplied).

- Specifies a decimal value or hexadecimal value that starts with "0x", which is larger than 
1 and the stack size does not overflow.

- This parameter can be specified only for recursive functions.

- This value is equivalent to the one specified in [Recursion Depth] in the [ Adjust Stack 
Size ] dialog box dialog box.

CALL= func This parameter specifies a callee function (name of callee function to be added).

- Specifies the function name in the same form as that for which the stack size is adjusted.

- Up to 1,024 functions can be specified, but only the function whose stack size is largest 
among the callee functions can be used for stack size adjustment.

- This specification is equivalent to functions added to [Callee Functions] in the [ Adjust 
Stack Size ] dialog box dialog box.
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(a) Example of a stack size specification file

(b) Output image before stack size specification file is read

[Caution] An example when all call chains are output in the text format (refer to "(2) Text format").

(c) Output image after stack size specification file is read

(4) Illegal specifications

The specifications listed below are illegal for stack size information.  

If the number of lines in a file exceeds the limit (refer to "A. 1 Quantitative Limits"), a dialog box appears and an 

error message is output to the dialog box and the message display area, then reading of the file is aborted.

- When a function name not used is specified

- When multiple specifications are made for one file in a file

- When no argument is specified for ADD, RECTIME, or CALL

- When a size specification information except for ADD, RECTIME, or CALL is specified

- When an illegal argument (value other than a decimal value, or hexadecimal value starting with "0x") is 

specified for ADD or RECTIME

- When an illegal argument (invalid function name) is specified for CALL

- When multiple parameters are specified for ADD or RECTIME 

- When RECTIME is specified for a non-recursive function

- When multiple function names are specified for one CALL

# sample.txt

# Specify 50 as the stack size of "_flib".

[flib], ADD=50

# Set 0 to the stack size of "_flib_zero" for changing the display.

[flib_zero], ADD=0

# Adjust the stack size (in hexadecimal) and specify the recursion depth (3 times).

sub2, ADD=0xa, RECTIME=3

# Add "sub4()" and "_flib" to the callee functions called through function pointer.

sub3, CALL=sub.c#sub4, CALL=[flib]

# Specify nothing.

sub.c#sub4

main(310,100)+--sub1(210, 200)---sub2*(10, 10)---sub2*(10, 10)

             +--sub3&(200, 200)---[flib_zero](?, ?)

             +--sub.c#sub4(50, 50)---[flib](?, ?)

main(400,100)+--sub1(260, 200)  +--sub2*(60, 10, +10*3)---sub2*(60, 10, +10*3)

             +-- sub3&(300, 200)+--sub.c#sub4(100, 50)---[flib](50, ?, +50)

             |                  +--[flib](50, ?, +50)

             |                  +--[flib_zero](0, ?, +0)

             +--sub.c#sub4(100, 50)---[flib](50, ?, +50)
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4. 2. 4  stk system file (.psg)

The stk system file is a file for saving stack size adjustment information.  The file name is fixed to "project-file-

name.psg".

The file contents are saved in the same format as that of the Stack size specification file (.txt), but reading and sav-

ing are performed automatically by the SK78K0/SK78K0R (only information of functions whose stack sizes have been

changed is saved).

[Caution] Do not modify the stk system file.

4. 2. 5  Output result file (.txt/.csv)

The stack size calculation results for a selected function can be output as an output result file, by selecting the out-

put content and file format.

(1) Output content

By using the following methods, the calculation results of the stack size of the call chain with maximum stack or 

of all call chains will be output.

- By selecting [Save Call Chain with Maximum Stack...] from the [File] menu, only a call chain whose stack 

size is the largest among those starting from the selected function will be output.

- By selecting [Save All Call Chains...] from the [File] menu, the stack sizes of all call chains, starting from the 

selected function will be output.

The file format can be selected from the Text format or CSV format, when saving the file.

(2) Text format

If the text format is selected, the result is output in the form of a call tree.  

If there are multiple callee functions, "+--" is placed between the caller and the calee.  If there is only one callee, 

"---" is placed there.

Each line can contain up to 5,119 characters; the 5,120th and subsequent characters are displayed in a new line.  

The maximum number of output lines is 32,767.  If there are 32,768 lines or more, a warning message is dis-

played, and output is aborted.

Information of each function is output in the following format.  Parameters in brackets are not output if unneces-

sary.

- Function [Auxiliary mark] (Total stack size, frame size [, adjustment information])
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Table 4-2 Parameters of stk System File

(a) Example in which all the call chains are output ([File] menu -> [Save All Call Chains...])

(b) Example in which the call chain with the maximum stack is output ([File] menu -> [Save Call Chain 

with Maximum Stack...])

Parameter Description

Function The function name defined in the C source file is output.
If the name of the C source file that includes the function definition is unknown, like 
functions manually coded in assembly language or library functions, the function 
name, from which an underscore ( _ ) at the top of the symbol name in the assem-
bler source file is excluded, is enclosed with brackets ([ ]).
When the function is a static function, the function name is preceded with the file 
name (without path) and "#", or "file-name # function-name".

Auxiliary mark A symbol that indicates the function type is output.

- "*": Recursive function

- "&": Function including an indirect call that uses a function pointer

Total stack size "?" is displayed if the size is unknown, and "SIZEOVER" if the size exceeds the limit.

Frame size "?" is displayed if the size is unknown, and "SIZEOVER" if the size exceeds the limit.

Adjustment information This item is output when the Additional margin (+size) or Recursion depth (*time) 
(for recursive functions) is specified.  If not specified, nothing is output.

- +size (additional margin)
A value specified in [Additional Margin] in the [ Adjust Stack Size ] dialog box or 
"ADD=" in the Stack size specification file (.txt) (decimal value).

- *time (recursion depth)
A value specified in [Recursion Depth] in the [ Adjust Stack Size ] dialog box or 
"RECTIME=" in the Stack size specification file (.txt) (decimal value).

main(800,80)+--sub1(720,240)---sub2(480,200)+--sub3(280,280)

            |                               +--sub31(160,160)

            +--sub11*(500,30,+20*10)---sub11*(500,30,+20*10)

            +--sub12&(400,200)---sub21(200,200)

            +--f.c#sub13(300,250,+50)

            +--sub14(50,?,+50)

            +--sub15(?,?)

main(800,80)+--sub1(720,240)---sub2(480,200)+--sub3(280,280)
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(3) CSV format

If the CSV format is selected, the same content as that in the Text format is output in the following form, where a 

call chain is composed of function names and function information, each element delimited by a comma (,).  

Unlike the text format, however, the CSV format outputs a message without starting a new line when the number 

of characters per line exceeds the limit, and outputting of the file is aborted.

Information of each function is output in the following format.

- Function name [auxiliary mark], total stack size, frame size, adjustment information

The content of each parameter is the same as that in the text format.  

In the case of the CSV format, however, "0" is output for the adjustment information of functions to which no 

adjustment information is specified ("+0" is output if "0" is specified for the additional margin).

(a) Example in which all the call chains are output ([File] menu -> [Save All Call Chains...])

(b) Example in which the call chain with the maximum stack is output ([File] menu -> [Save Call Chain 

with Maximum Stack...])

Function name, total stack size, frame size, adjustment information

main,800,80,0,sub1,720,240,0,sub2,480,200,0,sub3,280,280,0

main,800,80,0,sub1,720,240,0,sub2,480,200,0,sub31,160,160,0

main,800,80,0,sub11*,500,30,+20*10,sub11*,500,30,+20*10

main,800,80,0,sub12&,400,200,0,sub21,200,200,0

main,800,80,0,f.c#sub13,300,250,+50

main,800,80,0,sub14,50,?,+50

main,800,80,0,sub15,?,?,0

Function name, total stack size, frame size, adjustment information

main,800,80,0,sub1,720,240,0, sub2,480,200,0,sub3,280,280,0



CHAPTER 5  WINDOW REFERENCE

26 User’s Manual  U18950EJ1V0UM

CHAPTER 5  WINDOW REFERENCE

5. 1  Overview of Windows and Dialog boxes of SK78K0/SK78K0R

The windows and dialog boxes used in the SK78K0/SK78K0R are listed below.

Table 5-1 Windows and Dialog boxes of SK78K0/SK78K0R

Window/Dialog Box Name Function

Main window A window used for basic manipulation of the SK78K0/SK78K0R.

[ Adjust Stack Size ] dialog box A dialog box used to set additional margin and callee functions.

[ Stack Size Unknown / Adjusted 
Function Lists ] dialog box

A dialog box that displays a list of functions whose stack size is not 
unknown or functions already set.

[ Open ] dialog box A dialog box used to specify a Project file (.prj) or Stack size 
specification file (.txt) to be read.

[ Save As ] dialog box A dialog box used to specify the name and location of an Output 
result file (.txt/.csv) or Stack size specification file (.txt) to be saved.

[ About sk78k0/sk78k0r ] dialog box A dialog box that displays the version of the SK78K0/SK78K0R.
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5. 2  Explanation of Windows/Dialog Boxes

In this section, windows/dialog boxes of the SK78K0/SK78K0R are explained in the following format.

Window/Dialog box name

A name of the window or dialog box is shown in the frame.

In this part, the screens of the window or dialog box, functional outline, and opening methods are explained.  

Explanation of each area

The settings for each area and the displayed items in the window/dialog box are explained.

Menubar

The menu items pulled down from the relevant menubar items are listed, and their functions are explained.

Toolbar

The functions of buttons on the toolbar are explained.

Function buttons

Operations performed by clicking the buttons in the dialog box are explained.
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Main window

The Main window appears first after the SK78K0/SK78K0R starts up.  It displays the call tree and the stack size for

each function.

Figure 5-1 Main Window (When Using SK78K0)

[Note] When using the SK78K0R, "sk78k0r" is displayed on the title bar.

This section describes the following items.

- Explanation of each area

- Menubar

- Toolbar

- Statusbar

Menubar

List view areaTree view area Message display area

Toolbar

Statusbar
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Explanation of each area

(1) Tree view area

This area displays the function call tree.  

Functions are not sortable or movable by dragging icons into this area.

Figure 5-2 Tree View Area

The colors of icons indicate the function statuses (in the order of priority), as follows.

Table 5-2 Colors and Meanings of Function Icons

For example, if a setting of an undetermined function whose stack size is not unknown (yellow), recursive func-

tion (green), or ordinary function (white) is changed in the [ Adjust Stack Size ] dialog box or in the Stack size 

specification file (.txt), the icon color is changed to light blue (or red if the stack size becomes the largest among 

the callee functions), if the settings are initialized by specifying reset in the [ Adjust Stack Size ] dialog box or 

selecting [Reset Function] from the [Option] menu, the original icon color is restored.

Settings cannot be made for individual locations.  In the example in Figure 5-2, if a setting is made for "[_mul]", 

which is called from "sub11", the setting is reflected in "[_mul]", which is called from "sub3".

By right-clicking the mouse in this area, the following shortcut menu is displayed.

Icon Description

Red Function whose stack size is largest among the callee functions.

Light blue Function whose stack size was changed or to which a callee function was added.

Light green Recursive function or function in the chain of recursion.

Yellow Undetermined function whose stack size is not unknown.

White Other functions (ordinal functions)

[Adjust Stack Size...] Opens the [ Adjust Stack Size ] dialog box for the selected function.
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(2) List view area

This area lists the functions selected in the Tree view area and its callee functions.

Figure 5-3 List View Area

The contents of the listed items are as follows.

By clicking the column header over the list, the listed items are sorted according to the column clicked.

Table 5-3 Items in List View Area 

Column Description Sorted by:

Function The function name defined in the C source file is displayed.
If the name of the C source file that includes the function definition is 
unknown, like functions manually coded in assembly language or library 
functions, the function name, from which an underscore ( _ ) at the top of 
the symbol name in the assembler source file is excluded, is enclosed with 
brackets ([ ]).
When the function is a static function, the function name is preceded with 
the file name (without path) and "#", or "file-name # function-name".
One or two of the following symbols is (are) appended according to the 
function type.

- "*": Recursive function

- "&": Function including an indirect call that uses a function pointer

Name order

Total Stack Size "?" is displayed if the size is unknown, and "SIZEOVER" if the size exceeds the 
limit (refer to "Total stack size".). 

Size order

Frame Size "?" is displayed if the size is unknown, and "SIZEOVER" if the size exceeds the 
limit (refer to "Frame size".). .

Size order

Additional Margin Nothing is displayed if no additional margin is specified.
For a recursive function for which Recursion depth is specified, "* recursion 
depth" is displayed following this display (refer to "Additional margin".). 

Size order

File Displays the name of C source files in which the function is defined.
Nothing is displayed if there is no file including definition. 

Name order

Column header
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By right-clicking the mouse in this area, the following shortcut menus are displayed.

(3) Message display area

A Warning Messages or the progress status of processing by the SK78K0/SK78K0R is displayed.

Figure 5-4 Message Display Area

By right-clicking the mouse in this area, the following shortcut menus are displayed.

[Adjust Stack Size...] Opens the [ Adjust Stack Size ] dialog box for the selected function.

[Sort List by] Sorts the list view area according to the sort type selected from the following 
submenus.

[Function Name] Sorts the list view area in the order of function names (alphabetic order). 

[Icon Type] Sorts the list view area in the order of the function status (with higher priority)

[Stack Size] Sorts the list view area in the order of stack sizes.

[Frame Size] Sorts the list view area in the order of frame sizes.

[Additional Margin] Sorts the list view area in the order of additional margins.

[File Name] Sorts the list view area in the order of file names.

[Copy] Copies the selected text to the clipboard.

[Clear] Clears all the messages displayed.
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Menubar

(1) [File] menu

[Open Project...] Opens the [ Open ] dialog box, reads information of the selected 
project file, and calculates the stack size.

[Save Call Chain with Maximum Stack...] Opens the [ Save As ] dialog box and saves the call chain whose 
stack size is the largest among those starting from the selected 
function, in the Output result file (.txt/.csv).

Functions in the same manner as the  button.
This button is dimmed when no functions are selected.

[Save All Call Chains...] Opens the [ Save As ] dialog box and saves the call chains and 
stack sizes of all the functions, starting from the selected function, in 
the Output result file (.txt/.csv).
This button is dimmed when no functions are selected.

[Load Stack Size Specification File...] Opens the [ Open ] dialog box and reads information of the selected 

Stack size specification file (.txt).
This menu is dimmed if there are no relevant functions.

[Save Stack Size Specification File...] Opens the [ Save As ] dialog box and saves all of the functions 
whose stack size is unknown or functions whose size has been 
changed (including standard library) in the new Stack size 
specification file (.txt).
This menu is dimmed if there are no functions whose stack size is 
unknown or functions already set.

[Exit sk78k0]
/ [Exit sk78k0r]

Terminates the SK78K0/SK78K0R.
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(2) [View] menu

(3) [Option] menu

[Recalculate Stack Size] Recalculates the stack size and updates the display.

Functions in the same manner as the  button.

[Stop] Stops the jobs currently running.

Functions in the same manner as the  button.

[Sort List by] Sorts the list view area according to the sort type selected from the following 
submenus.
This menu is dimmed if there are no relevant functions.

[Function Name] Sorts the list view area in the order of function names (alphabetic order). 

[Icon Type] Sorts the list view area in the order of the function status (with higher priority)

[Stack Size] Sorts the list view area in the order of total stack sizes.

[Frame Size] Sorts the list view area in the order of frame sizes. 

[Additional Margin] Sorts the list view area in the order of additional margins. 

[File Name] Sorts the list view area in the order of file names.

[Stack Size Unknown / Adjusted Function Lists ...] Opens the [ Stack Size Unknown / Adjusted Function Lists ] 
dialog box and displays a list of functions whose stack size is 
unknown or functions that are already set.
This menu is dimmed if there are no relevant functions.

[Adjust Stack Size...] Opens the [ Adjust Stack Size ] dialog box and sets the size 
setting information of the selected function.

Functions in the same manner as the  button.
This button is dimmed when no functions are selected.

[Reset Function] Resets the settings of the selected function to the initial 
value and deletes information saved in the stk system file 
(.psg).
This button is dimmed if there is no size information set for 
the specified function.

[Reset All Functions] Resets the settings of all functions to the initial value and 
deletes information saved in the stk system file (.psg) (the 
standard library is re-set in the stk system file (.psg)).
This button is dimmed if there are no functions having size 
information.
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(4) [Help] menu

Toolbar

The toolbar includes the buttons that enable execution of comparatively frequently-used menu items by one-click.

Table 5-4 Toolbar Buttons

Statusbar

Explanations of functions of the selected menu items or buttons on the toolbar, and the progress bar that indicates

the processing status during file input/output are displayed.

Figure 5-5 Sratusbar

[SK78K0 Help]
/ [SK78K0R Help]

Opens the SK78K0/SK78K0R online help.

Functions in the same manner as the  button.

[About sk78k0...]
/ [About sk78k0r... .]

Opens the [ About sk78k0/sk78k0r ] dialog box and displays the SK78K0/
SK78K0R version information.

Buttons Function

Opens the [ Save As ] dialog box and saves the call chain whose stack size is the largest among the 
selected files, in the Output result file (.txt/.csv).
Functions in the same manner as when [Save Call Chain with Maximum Stack ...] is selected from 
the [File] menu.
This button is dimmed when no functions are selected.

Recalculates the stack size and updates the display.
Functions in the same manner as when [Recalculate Stack Size] is selected from the [View] menu.

Stops the jobs currently running.
Functions in the same manner as when [Stop] is selected from the [View] menu.

Opens the [ Adjust Stack Size ] dialog box and set the stack size of the selected function.
Functions in the same manner as when [Adjust Stack Size...] is selected from the [Option] menu.
This button is dimmed when no functions are selected.

Opens the SK78K0/SK78K0R online help.
Functions in the same manner as when [SK78K0 Help]/[SK78K0R Help] is selected from the [Help] 
menu.

The explanation of the selected function is displayed.
The message "For Help, press F1." is displayed by default.
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[ Adjust Stack Size ] dialog box

This is a dialog box used to set additional margins for the selected function, and callee functions.

Take either of the following actions to open this dialog box.

- Select a function in the Tree view area or List view area in the Main window, 

then select the [Option] menu -> [Adjust Stack Size...], or [Adjust Stack Size...] in the right-click menu

- Click the [Adjust Size...] button in the [ Stack Size Unknown / Adjusted Function Lists ] dialog box.

Figure 5-6 [ Adjust Stack Size ] Dialog Box

This section describes the following items.

- Explanation of each area

- Function buttons

(2) 

(1) 

(3) 

(4) 

(5) 

(6) 
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Explanation of each area

(1) Function Name:

Displays the name of the selected function.

This area cannot be edited.

(2) Frame Size:

Displays the Frame size.

"?" is displayed if the size is unknown, and "SIZEOVER" if the size exceeds the limit.

This area cannot be edited.

(3) Additional Margin:

Specify the Additional margin.  The specified margin is forcibly added to the stack size.

Specify a decimal value from 0 to 65,535, or a hexadecimal value starting with "0x".

If "0" is specified for a function whose stack size is "?", the indication will be changed from "?" to "0".

[Caution] A warning message is displayed if the stack size of upper functions overflows as a result of this set-

ting.

(4) Recursion Depth:

Specify the Recursion depth.  The value multiplied by its recursion depth is set for the stack size.

Specify a "1" or lager value within a range in which the stack size does not overflow, as a decimal value or a 

hexadecimal value starting with "0x".

This field is dimmed if the selected function is not a recursive function.

[Caution] A warning message is displayed if the stack size overflows as a result of this setting.

(5) Callee Functions:

Lists the functions to be called from the selected function.

"+" will be added at the top of the name of the functions added from [All Functions].

To delete a function from the list, select the function and click the [Delete] button (functions actually called are not 

deleted).

For details on the display format (function information), refer to "4. 2. 5  (2) Text format".

(6) All Functions:

Lists the functions used in the Assembler source module file (.asm) registered.

To add a function to [Callee Functions], select the function and click the [Add] button.

For details on the display format (function information), refer to "4. 2. 5  (2) Text format".
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Function buttons

Buttons Function

OK Saves the changes in the stk system file (.psg) and closes this dialog box.

Cancel Closes this dialog box without saving the changes. 

Reset Clears the settings made for the selected function and resets to the initial value.
The size setting information of the function is not deleted from the stk system file (.psg) until the 
[OK] button is clicked.
This button is dimmed if no settings were changed.

Help Displays the help topics for this dialog box.

Add Registers the function selected from [All Functions] to [Callee Functions].
This button is dimmed when no functions are selected in [All Functions].

Delete Deletes the function selected in [Callee Functions] (functions actually called are not deleted).
This button is dimmed when no functions are selected in [Callee Functions].
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[ Stack Size Unknown / Adjusted Function Lists ] dialog box

This is a dialog box that displays a list of functions whose stack size is not unknown or functions already set.

Take the following action to open this dialog box.

- Select [Option] menu -> [Stack Size Unknown / Adjusted Function Lists...]

Figure 5-7 [Stack Size Unknown / Adjusted Function Lists] Dialog Box

This section describes the following items.

- Explanation of each area

- Function button

(2) 

(1) 

(3) 
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Explanation of each area

(1) Unknown Functions

Lists undetermined functions whose stack size is unknown.

Functions listed here include functions manually coded in assembly language, library functions, functions that 

include an indirect function call using a function pointer, recursive functions, and functions with variable parame-

ters, for which no size setting information is specified.

(2) Adjusted Functions

Lists the functions for which additional margins are specified or functions for which the callee functions are 

changed (refer to "Additional margin").

If a function is displayed in this area but does not have adjustment information, the setting of its callee function 

has been changed.

(3) System Library Functions

Lists the standard library functions to which the stack size is automatically set by the SK78K0/SK78K0R.

Should resetting be executed by selecting [Reset Function]/[Reset All Functions] from the [Option] menu, this 

setting will be automatically re-set by the SK78K0/SK78K0R.

Function whose size settings were adjusted from the default setting are moved to [Adjusted Functions].

[Caution] For details on the display format (function information) of each list, refer to "4. 2. 5  (2) Text format".

Function button

Buttons Function

Close Closes this dialog box.

Adjust Size... Opens the [ Adjust Stack Size ] dialog box.
This button is dimmed when no functions are selected.

Help Displays the help topics for this dialog box.
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[ Open ] dialog box

This is a dialog box used to specify a Project file (.prj) or Stack size specification file (.txt) to be read.

Take either of the following actions to open this dialog box.

- Select [File] menu -> [Open Project...]

- Select [File] menu -> [Load Stack Size Specification File...]

Figure 5-8 [ Open ] Dialog Box

This section describes the following items.

- Explanation of each area

- Function button

(2) 

(1) 

(3) 
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Explanation of each area

(1) Look in:

Select from the drop-down list the drive or folder in which the file to be read exists.

The files stored in the specified location are listed below this area.

(2) File name:

Directly input from the keyboard the file name to be specified.

If a file name in the above field is clicked, the selected file name is displayed here.

(3) Files of type:

Select from the drop-down list the type (extension) of file to be specified.

The following file type is displayed by default.

- When this dialog box was opened by selecting the [File] menu -> [Open Project...] 

"Project File (*.prj)"

- When this dialog box was opened by selecting the [File] menu -> [Load Stack Size Specification File...]

"Stack Size Specification File (*.txt)"

Function button

Buttons Function

Open Loads information from the specified file.

Cancel Closes this dialog box without reading the file.
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[ Save As ] dialog box

This is a dialog box used to specify the name and location of an Output result file (.txt/.csv) or Stack size

specification file (.txt)) to be saved.

Take one of the following actions to open this dialog box.

- Select [File] menu -> [Save Call Chain with Maximum Stack...] 

- Select [File] menu -> [Save All Call Chains...] 

- Select [File] menu -> [Save Stack Size Specification File...] 

Figure 5-9 [ Save As ] Dialog Box

This section describes the following items.

- Explanation of each area

- Function button

(2) 

(1) 

(3) 
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Explanation of each area

(1) Save in:

Select from the drop-down list the drive or folder in which the file is to be stored.

The files already stored in the specified location are listed below this area.

(2) File name:

Directly input from the keyboard the file name to be saved.

If a file name in the above field is clicked, the selected file name will be displayed here.

(3) Save as type:

Select from the drop-down list the type (extension) of file to be saved.

Select one of the following file types.

- To save Output result file (.txt/.csv):

"Text Format Output Result (*.txt)": Saves the file as the text-format file

"CSV Format Output Result (*.csv)": Saves the file as the CSV-format file

- To save stack size specification file (.txt):

"Stack Size Specification File (*.txt)"

Function button

Button Function

Save Saves the file with the specified name and format.

Cancel Closes this dialog box without saving the file.
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[ About sk78k0/sk78k0r ] dialog box

This is a dialog box that displays the version of the SK78K0/SK78K0R.

Take the following action to open this dialog box.

- When using SK78K0: Select [Help] menu -> [About sk78k0...]

- When using SK78K0R: Select [Help] menu -> [About sk78k0r...]

Figure 5-10 [ About sk78k0/sk78k0r ] Dialog Box (When Using SK78K0)

This section describes the following items.

- Explanation of each area

- Function button

Explanation of each area

(1) Version information area

Displays the version of the SK78K0/SK78K0R as "Product name  Version  [Day Month Year]".

Function button

(1) 

Button Function

OK Closes this dialog box.
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CHAPTER 6  MESSAGES

6. 1  Display Format

Messages output by the SK78K0/SK78K0R are displayed in the Message display area and/or message dialog box

(refer to Figure 6-1).

The messages are classified into three types (refer to Table 6-1), and a letter that identifies the type is appended at

the top of the message number.

Figure 6-1 Message Dialog Box Example (When Using SK78K0)

Table 6-1 Message Types

Letter Type Displayed in:

E Error Messages Message dialog box only

W Warning Messages
Message display area and message dialog box

I Confirmation Messages
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6. 2  Error Messages

The error messages, error numbers, and their meanings are explained below.

The error messages are displayed only in the message dialog box, so the Main window is not opened.

In braces ({ }), the actual character string is displayed.

E9300: Cannot find project file ({path}).

The specified project file is not found.  Check that the file actually exists.

E9301: Project file read error ({path}). 

An error has occurred while the project file was read.  Reading of the project file may be prohibited.

E9302: Illegal format in project file ({path}).  Check the file

The format of the project file is illegal.  This error is output when an illegal format is found in the project file.  Mod-

ify the relevant code or recreate the project.

E9303: Failed to invoke file ({path}). 

Startup of the SK78K0/SK78K0R failed.  This error is output when the execution has failed to start the SK78K0/

SK78K0R.  

Retry startup of the SK78K0/SK78K0R.  If failure occurs again, there is a possibility that the SK78K0/SK78K0R 

was not installed normally, so reinstall the SK78K0/SK78K0R.
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6. 3  Warning Messages 

The warning messages, error numbers, and their meanings are explained below.

The warning messages are displayed in both the Message display area and the message dialog box.

The actual character string is displayed in braces ({ }), and the character string enclosed by brackets ([ ]) is displayed

only in the message dialog box.

The following buttons are displayed in the message dialog box for W9410 to W9426, and the action taken by the

SK78K0/SK78K0R varies depending on the button clicked, as shown in Table 6-2.

Table 6-2 Operation Performed by Clicking Buttons on Message Dialog Boxes for W9410 to W9426 

W9400: Cannot find file ({path}).  Check that the file is readable.   

The specified file does not exist.  Re-specify the correct file name.

W9401: Cannot open file to read ({path}).  Check that the file is readable.  

Reading of the file ({path}) is prohibited.  Check the attribute of the file and enable reading of the file.

W9402: Cannot open file to write ({path}).  Check that both the file and the folder are writable.  

This file ({path}) is read-only.  Check the attribute of the file and folder, and enable writing to the file.

W9403: File read error ({path}).  

An error occurred while the file ({path}) was read.  Check if the reading of the file is enabled.

W9404: File write error ({path}).  

An error occurred while the file ({path}) was written.  Check if the writing to the file is enabled.

W9405: Too many characters in one line in file ({path}: line {line number}).  The limit is ({num}).

Line {line number} in the file ({path}) includes characters that exceed the limit ({num}) of the number of charac-

ters per line.  For details on limits for each file, refer to "A. 1 Quantitative Limits".

W9406: Too many lines in file ({path}).  The limit is ({num}).  

The number of lines in the file ({path}) exceeds the limit ({num}) of the number of lines per file.  For details on lim-

its for each file, refer to "A. 1 Quantitative Limits".

W9407: Too long file name ({path}).  The limit is 255.  

The file name ({path}) is too long.  A file name containing 255 or more characters cannot be handled.  Check the 

file name.

Button Operation

Abort Cancels reading.

Retry Ignores the error line and continues reading from the next line.

Ignore Ignores the error line and continues reading from the next line.
No message dialog boxes are displayed for the subsequent warnings (W9410 to W9426), but 
the message is output to the Message display area only.
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W9410: Unknown function name ({function name}) in file ({path}: line {line number}).  Only functions explicitly 
referred to in the project are allowed.
[Do you want to stop reading?]

A function name ({function name}) that is not used in the project is specified in the Stack size specification file 

(.txt).

Only the functions whose definition or direct call is included in the C source file can be specified.  

For details, refer to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button in the message 

dialog box.

W9411: Too long file name ({file name}) qualifying static function name in file ({path}: line {line number}).  The limit is 
255.  
[Do you want to stop reading?]

A too-long file name, including the definition of a static function, which is appended at the top of the name, is 

found in the Stack size specification file (.txt).  Keep the length 255 or shorter.  Take action by clicking the button 

in the message dialog box.

W9412: Too long function name ({function name}) in file ({path}: line {line number}).  The limit is 1022.  
[Do you want to stop reading?]

A too-long function name is found in the Stack size specification file (.txt).  Keep the number of characters 1,022 

or fewer.  Take action by clicking the button in the message dialog box.

W9413: Illegal value ({value}) after "ADD=" in file ({path}: line {line number}).  
[Do you want to stop reading?]

An illegal specification of the additional margin is found in the Stack size specification file (.txt).  

Following "ADD=", specify a decimal value or a hexadecimal value from 0 to 65,535, starting with "0x" as the 

additional margin.  For details, refer to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the but-

ton in the message dialog box.

W9414: Multiple "ADD="s for one function in file ({path}: line {line number}).
Only one is allowed.
[Do you want to stop reading?]

An illegal specification of the additional margin is found in the Stack size specification file (.txt).

Only one type of additional margin can be specified for a function.  For details, refer to "4. 2. 3 Stack size 

specification file (.txt)".  Take action by clicking the button in the message dialog box.

W9415: )Illegal value( {value}) after "RECTIME=" in file ({path}: line {line number}).
[Do you want to stop reading?]

An illegal specification of the recursion depth is found in the Stack size specification file (.txt)

Following "RECTIME=", specify a positive decimal value or a positive hexadecimal value starting with "0x" as the 

recursion depth.  For details, refer to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button 

in the message dialog box.
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W9416: Multiple "RECTIME="s for one function in file ({path}: line {line number}). Only one is allowed. 
[Do you want to stop reading?]

An illegal specification of the recursion depth is found in the Stack size specification file (.txt)

Only one type of recursion depth can be specified for a function.  For details, refer to "4. 2. 3 Stack size 

specification file (.txt)".  Take action by clicking the button in the message dialog box.

W9417: Illegal "RECTIME=" for non-recursive function in file ({path}: line {line number}). It shall be specified for 
recursive functions.
[Do you want to stop reading?]

An illegal specification of the recursion depth is found in the Stack size specification file (.txt)

Specification of the recursion depth "RECTIME=" can only be used for recursive functions.  For details, refer to 

"4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button in the message dialog box.

W9418: Missing function name after "CALL=" in file ({path}: line {line number}).
[Do you want to stop reading?]

An illegal specification of callee functions is found in the Stack size specification file (.txt).

Specify a function name after "CALL=".  A function not used in the project cannot be specified.  For details, refer 

to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button in the message dialog box.

W9419: Multiple function names after "CALL=" in file ({path}: line {line number}).  
Place "CALL=" before each functions.
[Do you want to stop reading?]

An illegal specification of callee functions is found in the Stack size specification file (.txt).

Only one function can be specified after "CALL=".  To specify multiple functions, describe "CALL=" by the num-

ber of functions.  For details, refer to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button 

in the message dialog box.

W9424: Multiple specifications for one function in file ( path}: line {line number1}, line{line number2}).
Only one is allowed.
[Do you want to stop reading?]

Specifications for the same function are found on line {line number 1} and {line number 2} in the Stack size 

specification file (.txt).

Delete one of them.  Take action by clicking the button in the message dialog box.

W9425: Too many characters in one line in file ( path}: line {line number}).
The limit is 5119.
[Do you want to stop reading?]

Line {line number} in the Stack size specification file (.txt) exceeds the limit of the number of characters per line 

(5,119).

Reduce the number of callee functions specified.  Even if all of the callee functions are registered, only the stack 

size of the one with the largest stack size is added.  Take action by clicking the button in the message dialog box.
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W9426: Illegal format in file ({path}: line {line number}).
Check the file.
[Do you want to stop reading?]

Line {line number} in the Stack size specification file (.txt) includes an illegal format.

Check the file.  For details, refer to "4. 2. 3 Stack size specification file (.txt)".  Take action by clicking the button 

in the message dialog box.

W9427: Can not find stack size specification file for system library functions ( path}).
Default values (the same as {default file name}) are used.

The Stack size specification file (.txt) for the standard library is not found.  Size information held by the SK78K0/

SK78K0R (same as {default file name}) will be used instead.

The file may not have been installed normally, so reinstall it.

W9428: Illegal format in stack size specification file for system library functions ({path}: line {line number}).

The Stack size specification file (.txt) for the standard library includes an illegal format.

The file may not have been installed normally, so reinstall it.

W9429: Broken stk system file ({path}).  
The file was ignored.

The stk system file (.psg) is invalid.  Adjustment of the stack size performed previously and before may not be 

reflected correctly.  Check the file, and re-adjust the stack size if it has not been reflected correctly.

W9430: Cannot find CC78K0/CC78K0R generated assembler source module file.  Select PM+’s menu ([Tool]-[Com-
piler Options]) and check both "Create Assembler Source Module File" in [Output] tab and "Output Debug-
ging Information" in [Debug] tab and then rebuild.

The Assembler source module file (.asm) is not found.  Register the C source file in PM+, select [Tool] -> 

[Compiler Options] from the menubar, and select the "Create Assembler Source Module File" check box on the 

"Output" tab and the "Output Debugging Information" check box on the "Debug" tab, and then rebuild the assem-

bler source module file.

W9431: Cannot find CC78K0/CC78K0R generated assembler source module file ({path}).
Check "Compiler Options" specified for the corresponding C source file and rebuild.

The Assembler source module file (.asm) is not found.

Check that the "Create Assembler Source Module File" check box is selected for the corresponding C source file 

in [Compiler Options] in PM+, and then rebuild the assembler source module file. 

W9432: Illegal format in file ({path}: line {line number}).
Check the file. 

Line {line number} in the Assembler source module file (.asm) includes an illegal format.

The assembler source module file may not be the one generated by the CC78K0/CC78K0R.  Check the file and 

rebuild it

W9433: Cannot accept CC78K0/CC78K0R {version} generated assembler source module file.
Use {version} or later.

Since the version of the CC78K0/CC78K0R is old, the stack size cannot be calculated correctly if calling of the 

run-time library or standard library is included.  
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W9434: Assembler source module file for different device ({path}). 

The file ({path}) is the one generated by a compiler for another microcontrollers.  This file cannot be analyzed.

W9435: Assembler source module file generated by different version of CC78K0/CC78K0R ({path}).

The Assembler source module file (.asm) ({path}) is the one compiled by another version of the CC78K0/

CC78K0R.  This file cannot be analyzed.

W9440: Illegal project file ({path}).  Check the file.  

The project file is invalid.  Check the file.  

This error is output if a project file opened from the menubar after startup is invalid.

W9450: Number of lines reached limit (32767) in output.

The output result exceeds 32,767 lines.

Change the selection of the functions, or change the setting so that only the maximum call chain is output. 

W9451: Number of characters in one line reached limit (5119) in output.

A line in the output result includes 5,119 or more characters.

Change the selection of the function or output the file in the text format.  In the text format file, a linefeed is 

inserted.

W9460: Too many callee functions.
The limit is 1024.

The number of callee functions exceeds the limit.  Reduce the number to 1,024 or lower.  Even if all of the callee 

functions are registered, only the stack size of the one with the largest stack size is added.

W9461: Too many characters in specification for one function.
The limit is 5119.

The number of items in size setting information exceeds the limit of the number of characters (5,119).

Reduce the number of specifications of callee functions.  Even if all of the callee functions are registered, only 

the stack size of the one with the largest stack size is added.  The parameter names and separators (",") are 

included in 5,119 characters.

W9462: Illegal value ({character}) for additional margin.

An illegal value is specified as the additional margin.  Specify a decimal value or a hexadecimal from 0 to 65,535 

starting with "0x" as the additional margin.

W9463: Illegal value({character}) for recursion depth.

An illegal value is specified as the recursion depth.  Specify a positive decimal value or a positive hexadecimal 

value starting with "0x".

W9464: Too big additional margin.
The limit is 65535.

A value greater than 65,535 is specified as the additional margin.  Specify a value equal to or smaller than 

65,535.
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W9465: Total stack size exceeds 65535 in function ({function name}).
Reduce recursion depth.

The amount of stack consumed by the function exceeds 65,535.  Reduce the value of the recursion depth.

W9466: Total stack size exceeds 65535 in function( {function name}).
Reduce stack size in the maximum call chain.  

The amount of stack consumed by the function exceeds 65,535.  Reduce the stack size of functions in the call 

chain with maximum stack.
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6. 4  Confirmation Messages

The confirmation messages, error numbers, and their meanings are explained below.

The confirmation messages are displayed in both the Message display area and message dialog box.

The actual character string is displayed in braces ({ }).

The operation varies in the SK78K0/SK78K0R, depending on the button selected in the message dialog box. 

I9500: Exit sk78k0/sk78k0r.

The SK78K0/SK78K0R will be terminated.

To terminate the SK78K0/SK78K0R, click the [OK] button.

I9501: Do you want to overwrite it ?

The existing file will be saved as a new file.

To continue the action, click the [Yes] button.

To cancel the action, click the [No] button. 

I9502: Do you want to cancel adjustments to the selected function( {function name})?

The settings made for the function {function name} are going to be reset to the initial values.

To continue the action, click the [Yes] button.

To cancel the action, click the [No] button.

I9503: Do you want to cancel adjustments to all the functions?

The settings made for all functions will be reset to the initial values.

To continue the action, click the [Yes] button.

To cancel the action, click the [No] button.



  

54 User’s Manual  U18950EJ1V0UM

APPENDIX A  QUANTITATIVE LIMITS

A. 1  Quantitative Limits

The limits and the range settings are as follows. 

Table A-1 Quantitative Limits

[Note] In the text format file, a line is wrapped at the 5,119th character.

Item Limit

Project file (.prj)-related Number of files (can be specified by user) 1

Length of file name 255

Number of characters per line 5,119

Number of lines per file 2,097,152

Assembler source module file 
(.asm)-related

Number of files (cannot be specified by user) 2,048

Length of file name 255

Length of symbol name 1,022

Number of characters per line 5,119

Number of lines per file 65,535

Stack size specification file (.txt)-
related

Number of files 
(number of files that can be read at once) 

1

Length of file name 255

Number of characters per line 
(including element name and separator) 

5,119

Number of functions that can be specified in one line 1

Number of callee functions that can be specified in 
one line (one function)

1,024

Number of lines per file 32,767

Number of functions that can be registered (= num-
ber of lines) 

32,767

Output result file (.txt/.csv)-related Length of file name 255

Length of one line [Note] 5,119

Number of lines per file 32,767

Stack size-related Number of adjustment information specifications 1,024

Additional margin specification 0 to 65,535

Recursion depth A value that does not
exceed the limit as a
result of multiplying
by the stack size

Stack size limit 65,535

Message display area Number of characters per line 5,119

Number of lines 32,767
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